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1.​ What is the Formula for Rounding off the Number fully without any decimal? 

a.​ =ROUND(NUMBER,0) 

b.​ =ROUND(NUMBER,1) 

c.​ =ROUND(NUMBER,2) 

d.​ =ROUND(NUMBER) 

Ans: a. =ROUND(NUMBER,0) 

Explanation: The ROUND() function in Excel is used to round a number to a specified 

number of digits. 

2.​ How to find the current date and time in excel? 

a.​ Now () 

b.​ Current date () 

c.​ Date time () 

d.​ Today () 

Ans: a. Now () 

Explanation:The NOW() function in Excel returns the current date and time. Simply enter 

=NOW() in a cell, and it updates automatically whenever the sheet recalculates or 

reopens. 

3.​ If the cell B2 is 68, what will this IF function give you as a result? 

=IF (B2>60, ''pass'', ''fail'') 

a.​ pass 

b.​ fail 

c.​ 60 

d.​ error 

Ans:  a. pass 

Explanation: The IF function checks if B2 is greater than 60. Since B2 is 68, the condition 

is TRUE, so it returns "pass". 
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4.​ Which statement best describes the SUMIF function in Excel? 

a.​ Totals numbers together 

b.​ To sum values that meet a specific criteria 

c.​ To look for values that meet a specific criteria 

d.​ Adds numbers then finds the average 

Ans: b. To sum values that meet a specific criteria 

Explanation: The SUMIF function adds values that meet a specified condition. It takes 

three arguments:Range: Cells to evaluate, Criteria: Condition to meet, Sum_range 

(optional): Cells to sum (defaults to "range" if omitted) 

5.​ What would be the formula if you wanted to sum all numbers in a range below 500? 

a.​ =SUMIF(A1:A10,''<500'') 

b.​ =SUMIF(A1:A10,''>500'') 

c.​ =SUMIF(A1:A10,<500) 

d.​ =SUM(A1:A10& ''<500'') 

Ans: a. =SUMIF(A1:A10,''<500'') 

Explanation: The SUMIF function sums values based on a condition. To sum numbers in 

A1:A10 below 500, use: =SUMIF(A1:A10, "<500"). 

6.​ Which of the following formulas would change the text TROUBLE to trouble? 

a.​ =LOWER(A1) 

b.​ =UPPER(A1) 

c.​ =PROPER(A1) 

d.​ =SMALL(A1)MAX 

Ans: a. =LOWER(A1) 

Explanation: The LOWER() function in Excel converts all uppercase letters in a specified 

text string to lowercase. 
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7.​ What is the purpose of the IF function in Excel? 

a.​To perform mathematical calculations 

b.​ To create conditional statements 

c.​ To generate random numbers 

d.​ To format cells 

Ans: b. To create conditional statements 

Explanation: The IF function in Excel is used to create conditional statements based on a 

specified condition. 

8.​  Which do you press to enter the current date in a cell? 

a.​ CTRL+SHIFT+: (colon) 

b.​ CTRL+; (semicolon) 

c.​ CTRL+F10 

d.​ ALT + + 

Ans : b. CTRL+; (semicolon) 

Explanation:This keyboard shortcut inserts the current date into the selected cell. It's a 

handy way to quickly add the current date without having to type it manually. 

9.​ What is 'Grouping' in Excel? 

a.​ Combining multiple cells into one 

b.​ Summarizing data from different sheets 

c.​ Outlining rows or columns to make a section collapsible 

d.​ Creating a group of charts 

Ans :  c. Outlining rows or columns to make a section collapsible 

Explanation: Grouping in Excel allows you to outline rows or columns so that you can 

collapse or expand sections of your worksheet. It's useful for managing large amounts of 

data and focusing on specific areas of your spreadsheet. 
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10.​How do you display the current date only in MS Excel? 

a.​Date () 

b.​Today () 

c.​ Now () 

d.​Time () 

Ans: b.Today () 

Explanation : DATE – returns the serial date value for a date 

TODAY – returns today’s date,NOW – returns the current date and time & TIME – 

assemble a proper time 

11.​What does COUNTA () function do? 

a.​ Counts cells having alphabets 

b.​ Counts empty cells 

c.​ Counts cells having number 

d.​ Counts non-empty cells 

Ans: d. Counts non-empty cells 

Explanation: COUNTA function counts cells containing any type of information, including 

error values. COUNTA function does not count empty cells. 

12.​In the formula, which symbol specifies the fixed columns or rows? 

a.​ $ 

b.​ * 

c.​ % 

d.​ ; 

Ans: a. $ 

Explanation: The absolute cell reference in excel is a cell address that contains a dollar 

sign ($). It can precede the column reference, the row reference or both. 
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13.​You can check the conditions against __________ when applying conditional formatting. 

a.​ Cell value 

b.​ Formula 

c.​ Both of the above 

d.​ Selected range 

Ans: c. Both of the above 

Explanation: When applying conditional formatting in Excel, you can check conditions 

against both the cell value and formulas. This allows you to apply formatting based on 

specific values in cells or based on the evaluation of certain formulas. 

14.​Which of the following is not true regarding Conditional Formatting? 

a.​ You can add more than one condition to check 

b.​ You can set condition to look for Bold and apply Italics on them 

c.​ You can apply Font border and pattern formats that meets the specified 

conditions 

d.​ You can delete any condition from Conditional Formatting dialog box if it is not 

required 

Ans: b. You can set condition to look for Bold and apply Italics on them 

Explanation : In Conditional Formatting we cannot set conditions to look for Bold and 

apply Italics on them. 

15.​Which formula adds the numbers in cells A1 to A5? 

a.​ =SUM(A1:A5) 

b.​ =ADD(A1:A5) 

c.​ =TOTAL(A1:A5) 

d.​ =AVERAGE(A1:A5) 

Ans: a. =SUM(A1:A5) 

Explanation: The SUM function adds all the numbers in the specified range of cells. 
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16.​What is the result of the formula =MOD(10,3) in Excel? 

a.​ 3 

b.​ 1 

c.​ 10 

d.​ 0 

Ans: b. 1 

Explanation: The MOD function returns the remainder when 10 is divided by 3, which is 1. 

17.​Which function is used to calculate exponents in Excel? 

a.​ POWER 

b.​ SUM 

c.​ CEIL 

d.​ COUNT 

Ans: a. POWER 

Explanation: The POWER function raises a number to a specified exponent, such as 

POWER(2,3) returning 8. 

18.​Which function combines text from multiple cells into one in Excel? 

a.​ CONCATENATE 

b.​ MERGE 

c.​ COMBINE 

d.​ JOIN 

Ans: a. CONCATENATE 

Explanation: The CONCATENATE function joins text from multiple cells into one 

continuous string. 
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19.​What does the LEN function return? 

a.​ The length of the string in characters 

b.​ The number of words in a text 

c.​ The total number of numbers in a range 

d.​ The first character of a text 

Ans: a. The length of the string in characters 

Explanation: The LEN function counts and returns the total number of characters in a 

text, including spaces. 

20.​What is the result of =LEFT("Excel", 2)? 

a.​ El 

b.​ Ex 

c.​ Exc 

d.​ cel 

Ans: Ex 

Explanation: The LEFT function extracts the first two characters from the text "Excel," 

which results in "Ex." 

21.​Which of the following is invalid statement? 

a.​ Sheet tabs can be coloured 

b.​ Some picture can be applied as a background of a sheet 

c.​ You can set the column width automatically fit the amount of text 

d.​ The width of a row fit automatically 

Ans: d. The width of a row fit automatically 

Explanation : The width of a row and be specified manually or fit automatically is invalid 

statement. 
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22.​How can you remove borders applied in cells? 

a.​ Choose None on Border tab of Format cells 

b.​ Open the list on Border tool in Format Cell toolbar then choose first tool (none) 

c.​ Using keyboard shortcut Ctrl+B 

d.​ Both a & b 

Ans: d. Both a & b 

Explanation : On the Home tab, in the Font group, click the arrow next to Borders Button, 

and then click No Border Button. 

23.​How can you display all numbers between 0 and 100 in red color? 

a.​ Use =if() function to format the required numbers red 

b.​ Apply Conditional Formatting command on Format menu 

c.​ Select the cells that contain number between 0 and 100 then click Red color on 

Text Color tool 

d.​ All of the above 

Ans: b. Apply Conditional Formatting command on Format menu 

Explanation : A conditional format changes the appearance of cells on the basis of 

conditions that you specify.  

24.​How can you display long text on multiple lines within a cell? 

a.​ Wrap Text in Format > Cells 

b.​ Justify in Edit > Cells 

c.​ Text Wrapping in Format > Cells 

d.​ All of the above 

Ans: a. Wrap Text in Format > Cells 

Explanation : Microsoft Excel can wrap text so it appears on multiple lines in a cell. We 

can format the cell so the text wraps automatically, or enter a manual line break. 
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25.​Which Excel function returns TRUE or FALSE based on multiple conditions? 

a.​ =AVERAGEIFS 

b.​ =CONCAT 

c.​ =COUNTA 

d.​ =AND  

Ans: d. =AND 

Explanation: The =AND() function checks whether all of the conditions provided to it are 

TRUE. If all conditions are TRUE, =AND() returns TRUE; otherwise, it returns FALSE. 

26.​Which function is used to count the number of cells in a range that contain a specific 

value? 

a.​ COUNTIF 

b.​ SUMIF 

c.​ AVERAGEIF 

d.​ MAXIF 

Ans: a. COUNTIF 

Explanation:  The COUNTIF function is used to count the number of cells in a range that 

contain a specific value.  

27.​Which function is used to return a specified number of characters from the beginning 

of a string of text in Excel? 

a. TEXT 

b. VALUE 

c. CONCATENATE 

d. LEFT 

Ans: d. LEFT 

Explanation: The LEFT function is used to return a specified number of characters from 

the beginning of a string of text in Excel. 
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28.​What does Cell Calculative Mode in Excel control? 

a.​ How cell references are formatted. 

b.​ How formulas are calculated and updated. 

c.​ The color of cells with formulas. 

d.​ The size of the cells with data. 

Ans: b. How formulas are calculated and updated. 

Explanation: This mode determines when and how formulas recalculate in a worksheet. 

29.​What happens in Automatic Calculation Mode in Excel? 

a.​ Formulas only update when manually triggered. 

b.​ Excel updates formulas instantly when a change is made. 

c.​ Formulas do not update at all. 

d.​ Excel calculates only the first formula entered. 

Ans: b. Excel updates formulas instantly when a change is made. 

Explanation: In Automatic Calculation Mode, formulas update automatically when data 

changes. 

30.​Which mode is best for large spreadsheets where recalculating everything after each 

change would slow down performance? 

a.​ Automatic Calculation Mode 

b.​ Manual Calculation Mode 

c.​ Dynamic Calculation Mode 

d.​ Fast Calculation Mode 

Ans: b. Manual Calculation Mode 

Explanation: Manual Calculation Mode improves performance by preventing frequent 

automatic recalculations. 
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31.​What does a Cell Address in Excel represent? 

a.​ The color of a cell. 

b.​ The unique identifier for a cell, based on its column letter and row number. 

c.​ The formula used within a cell. 

d.​ The content type of a cell (text, number, etc.). 

Ans: b. The unique identifier for a cell, based on its column letter and row number. 

Explanation: A cell address consists of a column letter and a row number (e.g., A1). 

32.​Which of the following is a valid cell address in Excel? 

a.​ A1 

b.​ 1A 

c.​ A-1 

d.​ 1B 

Ans: a. A1 

Explanation: Excel cell addresses always have a letter first (column) followed by a 

number (row). 

33.​Which of the following is an example of Absolute Addressing in Excel? 

a.​ =A1 + B1 

b.​ =$A$1 + $B$1 

c.​ =A$1 + B$1 

d.​ =A1 + B$1 

Ans: b. =$A$1 + $B$1 

Explanation: Absolute addressing uses "$" to lock both row and column references. 

 

 

 

 
IT Support and Development Training Programme​  
Creating Employable Engineers and Entrepreneurs  
 



 

Name of the Bundle Office Productivity  Bundle V2 (2025) Subject MS Excel 

Topic Perform Simple Calculations with 
Functions Last updated on 2 April  2025 

 
34.​In Mixed Addressing, what does $A1 represent? 

a.​ The column reference is fixed, and the row reference is relative. 

b.​ The row reference is fixed, and the column reference is relative. 

c.​ Both the column and row references are fixed. 

d.​ Neither the column nor the row reference is fixed. 

Ans: a. The column reference is fixed, and the row reference is relative. 

Explanation: The "$" before A locks the column, while the row can change dynamically. 

35.​Which Excel function returns the current date? 

a.​ =TIME() 

b.​ =TODAY() 

c.​ =NOW() 

d.​ =DATE() 

Ans: b. =TODAY() 

Explanation: The =TODAY() function returns the current date without time. 

36.​Select the function related to Date & Time in Excel. 

a.​ The current time. 

b.​ The current date and time. 

c.​ The current day of the week. 

d.​ The date of the next Sunday. 

Ans: b. The current date and time. 

Explanation: The =NOW() function provides both date and time at the current moment. 
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37.​What does the =DAY() function return in Excel? 

a.​ The day of the week for a given date. 

b.​ The day of the month for a given date. 

c.​ The total number of days in a month. 

d.​ The number of working days between two dates. 

Ans: b. The day of the month for a given date. 

Explanation: The =DAY() function extracts the day (1–31) from a given date. 

38.​Which formula is used to count salaries over $100,000 or joining dates after April 30? 

a.​ =COUNTIFS(F5:F24,”>100000″,E5:E24,”>44681″) 

b.​ =COUNTIF(F5:F24,”>100000″)+COUNTIF(E5:E24,”>44681″) 

c.​ =SUMIF(F5:F24,”>100000″)+COUNTIF(E5:E24,”>44681″) 

d.​ Both a & b 

Ans: d. Both a & b 

Explanation: Formula (a) counts values in F5:F24 over $100,000 and values in E5:E24 

after April 30.Formula (b) separately counts values in F5:F24 over $100,000 and values in 

E5:E24 after April 30, then adds the results. 

39.​Which formula calculates the average salary of male employees? 

a.​ =AVERAGEIF(C5:C24,”Male”,F5:F24) 

b.​ =AVERAGEIFS(F5:F24, C5:C24, "Male") 

c.​ =IF(C5:C24=”Male”,AVERAGE(F5:F24),””) 

d.​ =MEANIF(C5:C24,”Male”,F5:F24) 

Ans: a. =AVERAGEIF(C5:C24,”Male”,F5:F24) 

Explanation: This formula calculates the average of values in the range F5:F24 where the 

corresponding cells in the range C5:C24 meet the criteria "Male". 
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40.​Which function is used to convert a text string to lowercase letters in Excel? 

a.​ UPPER 

b.​ LOWER 

c.​ PROPER 

d.​ TEXT 

Ans: b. LOWER 

Explanation: The LOWER function is used to convert a text string to lowercase letters in 

Excel. 

41.​Which function is used to extract a specified number of characters from a text string in 

Excel? 

a.​ LEFT 
b.​ RIGHT 
c.​ MID 
d.​ TEXT 

Ans: c. MID 
Explanation: The MID function is used to extract a specified number of characters from a 
text string in Excel. 

42.​What is the correct syntax for the IF () function in Excel? 

a.​ =IF (condition, value_if_true, value_if_false) 
b.​ =IF (condition, value) 
c.​ =IF (condition) 
d.​ =IF (value_if_true, condition, value_if_false) 

Ans: a. =IF (condition, value_if_true, value_if_false) 
Explanation: The IF function checks a condition and returns one value if true and another 
if false. 
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43.​If you enter =IF(A1>10, "Greater", "Smaller") and A1 contains the value 5, what will be 

the result? 

a.​ "Greater" 
b.​ "Smaller" 
c.​ 10 
d.​ Error 

Ans: b. "Smaller" 

Explanation: Since 5 is not greater than 10, the function returns "Smaller". 

44.​What does the AND () function in Excel return? 

a.​ TRUE if any of the arguments are TRUE. 
b.​ TRUE only if all arguments are TRUE. 
c.​ FALSE if any of the arguments are TRUE. 
d.​ TRUE if one argument is FALSE. 

Ans: b. TRUE only if all arguments are TRUE. 

Explanation: The AND function returns TRUE only when all conditions are met. 

45.​In the formula =OR(A2>=10, B2<5), what would be the result if A2 = 12 and B2 = 3? 

a.​ TRUE 
b.​ FALSE 
c.​ Error 
d.​ "Yes" 

Ans: a. TRUE 

Explanation: Since A2 (12) is greater than or equal to 10, the OR function returns TRUE. 
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46.​What does the XOR () function do in Excel? 

a.​ It returns TRUE if all arguments are TRUE. 
b.​ It returns TRUE if one and only one argument is TRUE. 
c.​ It returns TRUE if both arguments are TRUE. 
d.​ It returns TRUE if neither argument is TRUE. 

Ans: b. It returns TRUE if one and only one argument is TRUE. 
Explanation: XOR (exclusive OR) returns TRUE when only one argument is TRUE, but 

FALSE if both are TRUE or both are FALSE. 

47.​The XOR function in Excel can take how many arguments? 

a.​ 1 argument 
b.​ 2 arguments 
c.​ 3 arguments 
d.​ More than 2 arguments 

Ans: d. More than 2 arguments 
Explanation: XOR can take multiple arguments and follows the exclusive OR logic. 

48.​Which of the following formulas will return the opposite of A2>=10? 

a.​ =NOT(A2>=10) 
b.​ =XOR(A2>=10) 
c.​ =AND(A2>=10) 
d.​ =OR(A2>=10) 

Ans: a. =NOT(A2>=10) 

Explanation: The NOT function reverses the logical value of the condition. 

49.​Given that A2 = TRUE and B2 = FALSE, which of the following formulas will return 

TRUE? 

a.​ =OR(A2, B2) 
b.​ =XOR(A2, B2) 
c.​ =AND(A2, NOT(B2)) 
d.​ All of the above 

Ans: d. All of the above 
Explanation: Each formula evaluates to TRUE based on logical operations. 
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50.​Which formula will return TRUE if A2 is not equal to 10? 

a.​ =NOT(A2=10) 
b.​ =A2<>10 
c.​ Both A and B 
d.​ =A2=10 

Ans: c. Both A and B 

Explanation: Both =NOT(A2=10) and =A2<>10 check for inequality. 

51.​If A2 = 10 and B2 = 5, what will =AND(A2>5, B2<10) return? 

a.​ TRUE 
b.​ FALSE 
c.​ Error 
d.​ 0 

Ans: a. TRUE 

Explanation: Since A2 is greater than 5 and B2 is less than 10, the AND function returns 
TRUE. 

52.​Which function is used to return the leftmost characters from a text string in Excel? 

a.​ LEFT 

b.​ RIGHT 

c.​ MID 

d.​ TEXT 

Ans: a. LEFT 

Explanation: The LEFT function is used to return the leftmost characters from a text 

string in Excel. 
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53.​Which function is used to return the rightmost characters from a text string in Excel? 

a.​ LEFT 
b.​ RIGHT 
c.​ MID 
d.​ TEXT 

Ans: b. RIGHT 

Explanation: The RIGHT function is used to return the rightmost characters from a text 
string in Excel. 

54.​Which function is used to count the number of characters in a text string in Excel? 

a.​ LEN 

b.​ COUNT 

c.​ MAX 

d.​ MIN 

Ans: a. LEN 

Explanation: The LEN function is used to count the number of characters in a text string 

in Excel. 

55.​Which function is used to find the position of a specific character in a text string in 

Excel? 

a.​FIND 

b.​SEARCH 

c.​ LOCATE 

d.​POSITION 

Ans: a. FIND 

Explanation: The FIND function is used to find the position of a specific character in a 

text string in Excel. 
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56.​Which function is used to replace a specified character or text string in a text string in 

Excel? 

a.​ REPLACE 

b.​ SUBSTITUTE 

c.​ CHANGE 

d.​ UPDATE 

Ans: b. SUBSTITUTE 

Explanation: The SUBSTITUTE function is used to replace a specified character or text 

string in a text string in Excel. 

57.​Which function rounds a number to a certain number of decimal places? 

a.​ ROUND 

b.​ ROUNDUP 

c.​ ROUNDDOWN 

d.​ TRUNC 

Ans: a. ROUND 

Explanation: The ROUND function is used to round a number to a specified number of 

decimal places in Excel. 

58.​Which function is used to round a number up to the nearest integer in Excel? 

a.​ ROUND 

b.​ ROUNDUP 

c.​ ROUNDDOWN 

d.​ TRUNC 

Ans: b. ROUNDUP 

Explanation: The ROUNDUP function is used to round a number up to the nearest integer 

in Excel. 
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59.​Which function is used to round a number down to the nearest integer in Excel? 

a.​ ROUND 

b.​ ROUNDUP 

c.​ ROUNDDOWN 

d.​ TRUNC 

Ans: c. ROUNDDOWN 

Explanation: The ROUNDDOWN function is used to round a number down to the nearest 

integer in Excel. 

60.​Which function is used to remove the decimal portion of a number in Excel? 

a.​ ROUND 

b.​ ROUNDUP 

c.​ ROUNDDOWN 

d.​ TRUNC 

Ans: d. TRUNC  

Explanation:  The TRUNC function is used to remove the decimal portion of a number in 

Excel. 

61.​Which function is used to calculate the average of a range of cells in Excel? 

a.​ SUM 

b.​ AVERAGE 

c.​ MAX 

d.​ MIN 

Ans: b. AVERAGE 

Explanation: The AVERAGE function is used to calculate the average of a range of cells in 

Excel. 
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62.​Which function is used to find the maximum value in a range of cells in Excel? 

a.​ SUM 

b.​ AVERAGE 

c.​ MAX 

d.​ MIN 

Ans: c. MAX 

Explanation: The MAX function is used to find the maximum value in a range of cells in 

Excel. 

63.​Which function is used to find the minimum value in a range of cells in Excel? 

a.​ SUM 

b.​ AVERAGE 

c.​ MAX 

d.​ MIN 

Ans: d. MIN 

Explanation: The MIN function is used to find the minimum value in a range of cells in 

Excel. 

64.​What does the PROPER function do in Excel? 

a.​ Converts text to uppercase 

b.​ Converts text to lowercase 

c.​ Capitalizes the first letter of each word in a text 

d.​ Extracts the first letter from a text 

Ans: c. Capitalizes the first letter of each word in a text 

Explanation: The PROPER function changes text to title case, meaning each word starts 

with a capital letter. 
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65.​Which of the following formulas correctly counts all non-empty cells in a range? 

a.​ =COUNTS(A1:A10) 

b.​ =COUNTA(A1:A10) 

c.​ =COUNTIF(A1:A10, “*”) 

d.​ =COUNTBLANK(A1:A10) 

Ans: b. =COUNTA(A1:A10) 

Explanation: The COUNTA function counts all non-empty cells, including those with text 

or numbers. 

66.​What is the correct syntax of the SUBTOTAL function? 

a.​ =SUBTOTAL(function_num, range) 

b.​ =SUBTOTAL(range, function_num) 

c.​ =SUBTOTAL(range) 

d.​ =SUBTOTAL(function_num, value1, value2) 

Ans: a. =SUBTOTAL(function_num, range) 

Explanation: The SUBTOTAL function applies a specified calculation (like SUM, 

AVERAGE) to a given range using function_num to define the operation. 

67.​Which function is used to find the largest value that is less than or equal to a specified 

value in a range of cells in Excel? 

a.​ COUNTIF 

b.​ SUMIF 

c.​ MAXIF 

d.​ LOOKUP 

Ans: d. LOOKUP 

Explanation: The VLOOKUP function is used to find the largest value that is less than or 

equal to a specified value in a range of cells in Excel. 
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68.​Which function is used to count the number of cells in a range that meet a specific 

criteria in Excel? 

a.​ COUNT 

b.​ SUM 

c.​ MAX 

d.​ COUNTIF 

Ans: d. COUNTIF 

Explanation: The COUNTIF function is used to count the number of cells in a range that 

meet a specific criteria in Excel. 

69.​Which function is used to sum the values in a range of cells that meet a specific 

criteria in Excel? 

a.​ COUNTIF 

b.​ SUMIF 

c.​ MAXIF 

d.​ VLOOKUP 

Ans: b. SUMIF 

Explanation: The SUMIF function is used to sum the values in a range of cells that meet a 

specific criteria in Excel. 

70.​Which function is used to return the highest value in a range of cells that meets a 

specific criteria in Excel? 

a.​ COUNTIF 

b.​ SUMIF 

c.​ MAXIFS 

d.​ VLOOKUP 

Ans: c. MAXIFS 

Explanation: The MAXIF function is used to return the highest value in a range of cells 

that meets a specific criteria in Excel. 
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71.​Which function is used to find the average of the cells in a range that meet a specific 

criteria in Excel? 

a.​ COUNTIF 

b.​ SUMIF 

c.​ AVERAGEIF 

d.​ VLOOKUP 

Ans: c. AVERAGEIF 

Explanation: The AVERAGEIF function is used to find the average of the cells in a range 

that meet a specific criteria in Excel. 

72.​Which function is used to return the value of a cell at a specified row and column 

within a range in Excel? 

a.​ MATCH 

b.​ INDEX 

c.​ VLOOKUP 

d.​ HLOOKUP 

Ans: b. INDEX 

Explanation: The INDEX function is used to return the value of a cell at a specified row 

and column within a range in Excel. 

73.​Which function is used to search for a value in the first row of a range of cells and 

return the value in the same column from a specific row in Excel? 

a.​ MATCH 

b.​ INDEX 

c.​ VLOOKUP 

d.​ HLOOKUP 

Ans: d. HLOOKUP 

Explanation: The HLOOKUP function is used to search for a value in the first row of a 

range of cells and return the value in the same column from a specific row in Excel. 
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74.​Which function is used to combine the contents of two or more cells into one cell in 

Excel? 

a.​ CONCATENATE 

b.​ JOIN 

c.​ MERGE 

d.​ COMBINE 

Ans: a. CONCATENATE 

Explanation: The CONCATENATE function is used to combine the contents of two or 

more cells into one cell in Excel. 

75.​Which function is used to split a text string into separate cells based on a delimiter in 

Excel? 

a.​ SPLIT 

b.​ SEPARATE 

c.​ TEXTSPLIT 

d.​ TEXTDELIM 

Ans: c. TEXTSPLIT 

Explanation: TEXTSPLIT is used to split a text string into multiple columns or rows based 

on a specified delimiter. 

76.​Which function is used to remove duplicate values from a range of cells in Excel? 

a.​ DUPLICATE 

b.​ DELETE 

c.​ REMOVE 

d.​ UNIQUE 

Ans: d. UNIQUE 

Explanation: The UNIQUE function is used to remove duplicate values from a range of 

cells in Excel. 
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77.​Which function is used to calculate the number of days between two dates in Excel? 

a.​ DATEDIF 

b.​ DATEVALUE 

c.​ DAY 

d.​ YEAR 

Ans: a. DATEDIF 

Explanation: The DATEDIF function is used to calculate the number of days between two 
dates in Excel. 

78.​Which function is used to convert a text string to a date value in Excel? 

a.​ DATEDIF 

b.​ DATEVALUE 

c.​ DAY 

d.​ YEAR 

Ans: b. DATEVALUE 

Explanation: The DATEVALUE function is used to convert a text string to a date value in 

Excel. 

79.​Which function is used to return the day of the month for a specified date in Excel? 

a.​ DATEDIF 

b.​ DATEVALUE 

c.​ DAY 

d.​ YEAR 

Ans: c. DAY 

Explanation: The DAY function is used to return the day of the month for a specified date 

in Excel. 
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80.​Which function is used to return the year for a specified date in Excel? 

a.​ DATEDIF 

b.​ DATEVALUE 

c.​ DAY 

d.​ YEAR 

Ans: d. YEAR 

Explanation: The YEAR function is used to return the year for a specified date in Excel. 

81.​Which function is used to calculate the total of a range of cells in Excel? 

a.​ MAX 

b.​ MIN 

c.​ SUM 

d.​ AVERAGE 

Ans: c. SUM 

Explanation: The SUM function is used to calculate the total of a range of cells in Excel. 

82.​Which function is used to count the number of cells in a range that meet a specified 

criteria in Excel? 

a.​ COUNT 

b.​ COUNTA 

c.​ COUNTIF 

d.​ COUNTBLANK 

Ans: c. COUNTIF 

Explanation: The COUNTIF function is used to count the number of cells in a range that 

meet a specified criteria in Excel. 
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83.​How do you count non-blank cells in a range? 

a.​ COUNT 

b.​ COUNTA 

c.​ COUNTIF 

d.​ COUNTBLANK 

Ans: b. COUNTA 

Explanation: The COUNTA function is used to count the number of non-blank cells in a 

range of cells in Excel. 

84.​Which function is used to count the number of blank cells in a range of cells in Excel? 

a.​ COUNT 

b.​ COUNTA 

c.​ COUNTIF 

d.​ COUNTBLANK 

Ans: d. COUNTBLANK 

Explanation: The COUNTBLANK function is used to count the number of blank cells in a 

range of cells in Excel. 

85.​Which function is used to apply a filter to a range of cells in Excel? 

a.​ FILTER 

b.​ SORT 

c.​ SEARCH 

d.​ FIND 

Ans: a. FILTER. 

Explanation: The FILTER function is used to apply a filter to a range of cells in Excel. 
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86.​Which function is used to sort a range of cells in Excel? 

a.​ FILTER 

b.​ SORT 

c.​ SEARCH 

d.​ FIND 

Ans: b. SORT 

Explanation: The SORT function is used to sort a range of cells in Excel. 

87.​Which function is used to search for a specific character or text within a string of text 

in Excel? 

a.​ FILTER 

b.​ SORT 

c.​ SEARCH 

d.​ FIND 

Ans: c. SEARCH 

Explanation: The SEARCH function is used to find the position of a character or text 

within a string, but it is not case-sensitive. If case sensitivity is required, the FIND 

function should be used instead. 

88.​Which function is used to convert a number into its corresponding text format in 

Excel? 

a.​ TEXT 

b.​ VALUE 

c.​ CONCATENATE 

d.​ LEFT 

Ans: a. TEXT 

Explanation: The TEXT function is used to convert a number into its corresponding text 

format in Excel. 
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89.​Which function is used to convert text into its corresponding numeric format in Excel? 

a.​ TEXT 

b.​ VALUE 

c.​ CONCATENATE 

d.​ LEFT 

Ans: b. VALUE 

Explanation: The VALUE function is used to convert text into its corresponding numeric 

format in Excel. 

90.​Which button automatically adds up selected numbers? 

a.​ AutoSum​ ​ ​ ​  

b.​ Filter 

c.​ Subtotal​ ​ ​ ​ ​  

d.​ Format 

Ans: a. AutoSum 

Explanation: The AutoSum button automatically adds up the selected numbers in a 

range. It quickly calculates the sum without needing to type the formula manually. 

91.​Which option can you calculate with the SUBTOTAL function? 

a.​ Sum 

b.​ Average 

c.​ Count 

d.​ All of the above 

Ans: d. All of the above 

Explanation: The SUBTOTAL function can calculate Sum, Average, Count, and other 

statistical operations, depending on the function number you use. 
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92.​In which tab can you find the Subtotal option? 

a.​ Insert tab​ ​ ​  

b.​ Home tab 

c.​ View tab​ ​ ​ ​  

d.​ Data tab  

Ans: d. Data tab 

Explanation: The Subtotal option is found in the Data tab. It allows you to automatically 

calculate subtotals for groups of data in Excel. 

93.​What does the SUBTOTAL function ignore when calculating totals? 

a.​ Hidden or filtered rows​ ​  

b.​ Blank cells 

c.​ Formulas in rows​ ​  

d.​ Conditional formatting 

Ans: a. Hidden or filtered rows 

Explanation: The SUBTOTAL function ignores hidden or filtered rows when calculating 

totals. 

94.​What does the AVERAGE function calculate? 

a.​ Subtracts numbers in a range. 

b.​ Add all the numbers together. 

c.​ Finds the average of a set of numbers. 

d.​ Filters data in a range. 

Ans: c. Finds the average of a set of numbers. 

Explanation: The AVERAGE function adds up all the numbers in a range and then divides 

the sum by the total number of values, giving you the average. 
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95.​Which shortcut opens the Insert Function dialog to search for the AVERAGE function? 

a.​ Shift + F3 

b.​ Ctrl + A 

c.​ Alt + = 

d.​ Ctrl + Shift + S 

Ans: Shift + F3 

Explanation: The shortcut Shift + F3 opens the Insert Function dialog, allowing users to 

search for and insert functions, including AVERAGE. Alt + = is specifically used for 

AutoSum, which quickly inserts the SUM function. 

96.​Allowing data values within a specific range for entry in a cell is called _____ of data. 

a.​ Validation 

b.​ Sorting 

c.​ Filtering 

d.​ Chart 

Ans: a. Validation 

Explanation: Validation ensures that only allowed data values can be entered in a cell. 

97.​Which option in Data Validation limits entries to whole numbers? 

a.​ Whole Number 

b.​ Text 

c.​ Date 

d.​ Any Value 

Ans: a. Whole Number 

Explanation: The "Whole Number" option allows only integer values in the selected cell. 
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98.​What is prevented by the Data Validation feature? 

a.​ File corruption 

b.​ Formatting issues 

c.​ Incorrect data entry 

d.​ Cell duplication 

Ans: c.  Incorrect data entry 

Explanation: Data Validation ensures that only valid data is entered based on defined 

rules. 

99.​What does the Text Length option in Data Validation control? 

a.​ Limits the text entered 

b.​ Limits the number of characters 

c.​ Limits numbers only 

d.​ Limits dates only 

Ans: b. Limits the number of characters 

Explanation: The "Text Length" option restricts the number of characters in a cell. 

100.​ Which tab contains the option to unprotect a worksheet? 

a.​ File 

b.​ Insert 

c.​ Review 

d.​ Data 

Ans: c. Review 

Explanation: The "Unprotect Sheet" option is available under the Review tab. 
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101.​ What happens to blank cells in the AVERAGE function? 

a.​ Blank cells are ignored. 

b.​ Blank cells are treated as zero. 

c.​ The function gives an error. 

d.​ Blank cells are automatically removed. 

Ans: a. Blank cells are ignored. 

Explanation: In the AVERAGE function, blank cells are ignored when calculating the 

average. They don’t affect the result. 

102.​ Which function converts "hello world" into "HELLO WORLD"? 

a.​ UPPER​ ​ ​ ​  

b.​ LOWER 

c.​ PROPER​ ​ ​  

d.​ CAPITAL 

Ans: a. UPPER 

Explanation: The UPPER function converts text to uppercase. For example, 

=UPPER("hello world") will return "HELLO WORLD". 

103.​ What happens when you protect cells in Excel? 

a.​ Prevents editing certain cells 

b.​ Deletes data 

c.​ Formats cells 

d.​ Hides the sheet 

Ans: a. Prevents editing certain cells 

Explanation: Protecting cells ensures that only authorized users can edit them. 
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104.​ How can you protect a worksheet from being edited accidentally? 

a.​ Use a password 

b.​ Lock cells 

c.​ Both A & B 

d.​ Set as read-only 

Ans: c. Both A & B 

Explanation: Locking cells and using a password prevents accidental editing. 

105.​ What does the "Protect Workbook" option in Excel do? 

a.​ Prevents changes to the worksheet's data 

b.​ Restricts the addition, deletion, or moving of worksheets within the workbook 

c.​ Prevents anyone from opening the workbook 

d.​ Encrypts the workbook with a password 

Ans: b. Restricts the addition, deletion, or moving of worksheets within the workbook 

Explanation: "Protect Workbook" prevents structural changes like adding or deleting 

sheets. 

106.​ If you forget the password to unprotect a sheet in Excel, what happens? 

a.​ Excel will automatically unlock the sheet after a set period 

b.​ You can use the "Recover Password" feature in Excel 

c.​ The password cannot be recovered, and you must recreate the sheet 

d.​ You can contact Microsoft support for a password reset 

Ans: c. The password cannot be recovered, and you must recreate the sheet 

Explanation: Excel does not offer a built-in way to recover forgotten sheet passwords. 
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107.​ What is the maximum number of worksheets you can protect within a workbook in 

Excel? 

a.​ One worksheet at a time 

b.​ Up to 255 worksheets 

c.​ Up to 10 worksheets 

d.​ Unlimited number of worksheets 

Ans: d. Unlimited number of worksheets 

Explanation: Excel allows protecting all worksheets within a workbook without any limit. 

108.​ In Excel, which feature turns text-based time into a serial number? 

a.​ TIME 

b.​ TIMEVALUE 

c.​ SECOND 

d.​ NOW 

Ans: b. TIMEVALUE 

Explanation: The TIMEVALUE function converts text-formatted time into a serial number 

for calculations. 

109.​ Which formula counts cells with "Yes" in range A1:A10? 

a.​ =COUNTIF(A1:A10, "Yes") 

b.​ =SUMIF(A1:A10, "Yes") 

c.​ =AVERAGEIF(A1:A10, "Yes") 

d.​ =COUNT(A1:A10) 

Ans: a. =COUNTIF(A1:A10, "Yes") 

Explanation: The COUNTIF function counts cells in a range that meet a specific 

condition. 
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110.​ Which formula calculates the difference in years between two dates? 

a.​ =DATEDIF(A1, B1, "Y") 

b.​ =DATEDIF(A1, B1, "M") 

c.​ =DATEDIF(A1, B1, "D") 

d.​ =YEAR(B1) - YEAR(A1) 

Ans: a. =DATEDIF(A1, B1, "Y") 

Explanation: The DATEDIF function with "Y" returns the difference in years between two 

dates. 

111.​ Which formula will return 2 when the values in cells C1 to C6 are 5, 8, 3, 6, 2, and 9? 

a.​ =MIN(C1:C6) 

b.​ =MAX(C1:C6) 

c.​ =SUM(C1:C6) 

d.​ =AVERAGE(C1:C6) 

Ans: a. =MIN(C1:C6) 

Explanation: The MIN function returns the smallest value in a range, which is 2. 
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